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Using SAAM II Multiple I-O Experiments 

 
Multiple Input-Output Experiments 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” It will be 
helpful to have worked through the Using SAAM II Tutorial “Using Delays – Part 
1.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you have to deal with experiments with multiple 
inputs and multiple outputs. You will learn how to 
 

• Create multiple input-output experiments using the Duplicate command (Part 1). 
• Create multiple input-output experiments using Create Experiment in the 

SAAM II Toolbox (Part 2). 
 
Files Required 
 

Study Files: The study files for this tutorial are 
 

io_duplicate.stu 
io_expt.stu 
io_expt_final.stu 

 
The study file io_duplicate.stu is saved for convenience and can be used with 
Part 1. The study file io_expt.stu will be used for Part 2. The study file 
io_expt_final.stu is the study file created in Part 2. 

 
Data File: The data file for this tutorial is 

 
io.dat 

 
This file is included as part of this tutorial.  
 

Introduction 
 
There are many instances when your experimental protocol may call for multiple inputs. 
Examples in metabolic kinetics come from multiple tracer studies. For example, carbon 
and hydrogen labeled glucose can be injected (two-inputs) and both tracers followed in 
plasma samples (two-outputs). In pharmacokinetic studies, an example would be the iv 
and oral administration of a drug in the same individual. Normally this is done at 
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different times so the assumption has to be made that the subject is in the same “state” in 
both experiments. More recently, it has become possible to label a drug with a stable 
isotope. The drug and isotopically labeled drug can then be administered iv and orally 
(two-inputs), and plasma levels of drug and stable isotope followed (two-outputs). 
Finally, the increased use of tools such as MRI and PET is making multiple input-output 
studies more common. Multiple input-output studies will become more important 
especially in the pharmaceutical industry as the process of drug discovery and 
development becomes more sophisticated. 
 
There are two ways multiple input-output studies can be created in SAAM II. One uses 
the model duplication command in the Edit menu. Here, as illustrated in Part 1, you can 
create a model, and then duplicate the model structure. You have the option of having 
corresponding rate constants set equal, or they can be different. In Part 1, you will see 
that you can create a model for the iv system. Then you can duplicate this model, and add 
to it components to describe absorption. 
 
The other method uses the Create Experiment option in the SAAM II Toolbox. Here 
you first create the system model. In the system model, you can have inputs at different 
sites. SAAM II does the book keeping via the Create Experiment option. You create a 
different experiment for each input. 
 
The most common experiment is the single input experiment. When you create your 
experiment, the compartment names change from, for example, 1 to q1. When you create 
multiple experiments, q1 changes to, for example, q1.1 for a second experiment, q1.2 for 
a third experiment, etc. Using this option makes it much easier to keep track of the 
individual inputs and outputs. 
 
The data to be used in this tutorial come from a pharmacokinetic study in which a drug 
was first given iv, and then later via a suspension into the upper GI tract. 
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Part 1. Creating a Multiple Input-Output Experiment Using the Duplicate 
Command 

 
In this tutorial, you will simultaneously analyze data following an iv administration and 
oral suspension administration of a drug using the Duplicate command. In the iv 
experiment, the drug was infused for 20 minutes while in the suspension, it was given as 
a bolus. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Create the following system model for the iv data on the Drawing Canvas: 
 

 
3. In the SAAM II Toolbox, click Experiment. The Experiment Attributes dialog 

box will open. 
 

a. Type “480” in the End At box. The Experiment Attributes dialog box 
should appear as follows: 

 

 
 
b. Click Done. The Create Experiment dialog box will open as follows: 
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c. Click Create. The model will appear on the Drawing Canvas as follows: 
 

 
 

4. Add the data to your model. 
 

a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. In the File menu, click Open. The file io.dat should appear in the list (if it 

does not, find the folder where you have put this data file). 
 
c. Double-click io.dat. The data file contains drug data following the 20 minute 

constant infusion, “ivplasma”, and following the oral administration, 
“suspension.” The oral data will be used later. The Data window appears as 
follows: 
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The weighting scheme is FSD; you can leave the variance model set as the 
default data-relative.  

 
d. Close the Data window. 
 

5. Create a sample and an input 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then the Drawing Canvas. The sample s1 will 

appear associated with Compartment q1. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “ivplasma” in the Associate with Data Name box. 
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e. Edit the sample equation to read “s1=q1/V1”. The Sample Attributes dialog 

box will appear as follows: 
 

 
 
f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q1 and then the Drawing Canvas. The input ex1 will 

appear associated with Compartment q1. 
 
i. Specify the 20 minute infusion. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Infusion in the Input Type pane. 
 
(3) Type “12500” in the Constant Rate box. 
 
(4) Type “0” in the Event Start box. 
 
(5) Type “20” in the Event Stop box. 
 
(6) Click Add. The Exogenous Input dialog box should appear as follows: 
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(7) Click Done. The model will appear as follows: 
 

 
 

6. Enter the parameter values. 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 

The parameter V1 should be selected. If it is not selected, double-click V1. Be 
sure the Adjustable option is selected. 
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b. Type “13000” in the Value box, “2000” in the Low Limit box, “20000” in the 
High Limit box, and click Save. 

 
c. Double-click k(0,1) to select it. 
 
d. Type “0.07” in the Value box, and click Save. 
 
e. Double-click k(1,2) to select it. 
 
f. Type “0.02” in the Value box, and click Save. 
 
g. Double-click k(2,1) to select it. 
 
h. Type “0.2” in the Value box, and click Save. The Parameters dialog box 

should appear as follows: 
 

 
 
i. Click Done. 
 

7. Solve the model and view the solution. 
 

a. It will be helpful to have better resolution of your plots than the default. In the 
Compute menu, click Settings. The Computational Settings dialog box will 
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open. Change the entry in the Min. Nr. of Calculation Intervals from “20” to 
“200”. The Computational Settings dialog box should appear as follows: 

 

 
 

Click Done. 
 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 

 
c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected. 

 
d. Click s1:ivplasma; it will move to the Current Selection pane. 
 
e. Click Done. The following plot will appear (in linear mode): 
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f. Close the Plot window. 

 
You have now created the model which will be used to analyze the iv plasma data. The 
system model for the oral suspension data will now be created assuming once the drug 
enters plasma it behaves the same as the drug introduced using the iv infusion. 
 

8. Create the following system model for the oral suspension data using the 
Duplicate command. 

 

 
 

a. While pressing the CTRL key, click q1, q2 and s1. 
 
b. In the Edit menu, click Duplicate. The Duplicate dialog box will open. 
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c. Change the entry in the Start new Compartment/Delay numbers at box 
equal to “11”. Select the Set New Parameters Transfer Coefficients equal 
to counterparts box. The Duplicate dialog box will appear as follows: 

 

 
 
d. Click Duplicate. As instructed in the Duplicate dialog box, click on the 

Drawing Canvas approximately where you would like the duplicated model to 
appear. The following models will appear on the Drawing Canvas (after 
some rearrangement): 
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 Duplicating. The Duplicate command allows you to duplicate a model, or a 
portion of a model. There are several features that are important. 

 
• The duplicated sample s2 will appear associated with Compartment 

q11 (in this case). It is not, however, associated with data and hence 
the circle is open. In addition, the equation for the sample is “s2=q11”, 
that is, the equation for sample s1 does not carry over to s2. 

• You have the option of setting the compartment number from where 
the duplicated model will start. For this reason, the order in which you 
click the compartments as you begin the duplication process can be 
important. 

• You have the option of having the parameters of the duplicated model 
be different. In that case, the structure is preserved but the parameters, 
k(0,11), k(12,11) and k(11,12) would appear in the Parameters dialog 
box. The other option, the one chosen here, is to set the new 
parameters’ transfer coefficients equal to their counterparts. 

 
To see how this works, double-click, for example, k(0,11). The Loss 
Attributes dialog box will appear as follows: 
 

 
 
SAAM II has defined “k(0,11)=k(0,1” thus saving you the trouble of having 
to do this for every parameter in the duplicated model. (Of course, you can 
remove this equation if you wish in which case k(0,11) would appear as a 
parameter in the Parameters dialog box.) 
 
If the option of setting the parameters equal to their counterparts is chosen, it 
is necessary to Solve the original model first in order for the model to be 
created internally in SAAM II. 
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e. Create the model for oral absorption. 
 

(1) In the SAAM II Toolbox, click Model. The Model tools are now 
available. 

 
(2) In the SAAM II Toolbox, click Compartment. 

 
(3) Click on the Drawing canvas where you would like the new compartment 

to appear. Compartment 3 will appear. Double-click Compartment 3 to 
open the Compartment Attributes dialog box. Change the number of the 
compartment from “3” to “13”. The Compartment Attributes dialog box 
will appear as follows: 

 

 
 
  Click Done. 
 
(4) In the SAAM II Toolbox, click Delay. 
 
(5) Click on the Drawing Canvas where you would like the delay to be 

located. Place it between Compartments 13 and 11. Your model for the 
oral dose should appear as follows: 

 

 
 

(6) Double-click Delay 3. The Delay Attributes dialog box will open. 
 
(7) Change the entry in the Delay Time box to “tlag”. tlag will become an 

adjustable parameter equal to the delay time in absorption. 
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(8) Change the entry in the Number of compartments box to “5”. The Delay 
Attributes dialog box should appear as follows: 

 

 
 
(9) Click Done. 
 
(10) Add the fluxes k(0,13), k(3,13) and d(11,3). The model will appear as 

follows: 
 

 
 
 Remember the output from the delay is denoted by “d” to signify the 

fraction of the material in the delay moving along this transfer pathway. 
In this case, d(11,3) is equal to 1. 

 
9. Create an input into Compartment q13. 
 

a. In the SAAM II Toolbox, click Experiment to make these tools available. 
   
b. Click Input. 
 
c. Click Compartment q13 and then the Drawing Canvas. The input ex2 will 

appear associated with Compartment q13. 
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d. Double-click ex2 to open the Exogenous Input dialog box. Be sure “bolus” is 

selected as the Input Type. 
 
e. In the Initial Amount box, type “2.5e+05”. 
 
f. Click Add. 
 
g. Click Done. 

 
10. Associate s2 with the oral data, and change the sample equation. 
 

a. Double-click s2 to open the Sample Attributes dialog box. 
 
b. Type “suspension” in the Associate with Data Name box. 
 
c. Edit the sample equation to read “s2=q11/V1” The Sample Attributes dialog 

box will appear as follows: 
 

 
 

d. Click Done. Notice it is assumed that the volume of Compartments q1 and 
q11 are the same. 

 
11. Specify the new parameter values. 
 
 There are three new parameters to specify, tlag, k(0,13) and k(3,13). Compartment 

q13 is the compartment into which the suspension is introduced, and hence is 
really a part of the delay which is the GT tract. Thus Compartment q13 should 
turn over at approximately the same rate as the compartments in the delay. These 
turn over at the rate “tlag/5”, i.e. the delay time divided by the number of 
compartments in the delay. 

 
 However not all of the suspension may be absorbed. Define a new parameter “pa” 

equal to the fraction absorbed. Then you can write: 
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 k(3,13) = pa*(5/tlag) 
 k(0,13)=(1-pa)*(5/tlag) 
 
 This will allow you to estimate the fraction “pa”, or percent “pa*100”, of the drug 

in suspension absorbed. 
 

a. Double-click k(3,13) to open the Transfer Attributes dialog box. 
 
b. In the Equation pane, type the equation “k(3,13) = pa*(5/tlag)”. The 

Transfer Attributes dialog box will appear as follows: 
 

 
 
c. Click Done. 
 
d. Double-click k(0,13) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type the equation “k(0,13) = (1-pa)*(5/tlag)”.  
 
f. Click Done. 
 
g. Open the Parameters dialog box, and enter values as shown below for pa and 

tlag. 
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Notice the default Low and High Limits have not been used for pa or tlag. 
The reason for pa is that it is a fraction, and cannot exceed “1”. The reason for 
tlag is that the lag time cannot be longer than the experiment itself. 

 
h. Click Done. 
 

12. Solve the model and view the solution. The plot of s1:ivplasma and 
s2:suspension should appear as follows (in linear mode): 
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13. Fit the model to the data. The plot will be updated as follows: 
 

 
 
 
The statistics will appear as follows: 
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Close the Statistics and Plot windows. 
 

Quit the SAAM II Compartmental application. You may save this study file if you 
wish. The study file io_duplicate.stu is this study before the Fit. 

 

 Multiple input-output study. In studies such as this one where, on different 
occasions, a drug is administered iv and later orally (or in this case, as a 
suspension), there are two essential assumptions made when analyzing the 
data simultaneously: 

 
 Assumption 1: The subject is in the same “condition” during the two separate 

studies. That is, the determinants of how the drug is metabolized are the same 
on both days of the study. 

 
 Assumption 2: The metabolism of the drug that is absorbed into the systemic 

circulation is identical to that when the drug is introduced directly by iv. 
 
 For each such study, these assumptions must be considered if the “system 

model” is to be assumed identical for both studies. 
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Part 2. Creating a Multiple Input-Output Experiment Using Create Experiment 
 
In this tutorial, you will simultaneously analyze data following an iv administration and 
oral suspension administration of a drug by creating two separate experiments. In the iv 
experiment, the drug was infused for 20 minutes while in the suspension, it was given as 
a bolus. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file io_expt.stu. 

 
a. The file io_expt.stu should appear in the file list; if it does not, find the folder 

where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 

 
 

This is the system model which has been proposed to describe the drug data 
following an iv administration into plasma, Compartment 1, and into the GI 
tract, Compartment 4. Compartments 1 and 2 are proposed as the system 
model, i.e. to describe the drug kinetics in the body. Compartment 4 is 
proposed to be the upper end of the GI tract, the compartment into which the 
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drug suspension is administered. The Delay 3 represents transit through the GI 
tract. The characteristics of the delay have been set in that the delay time is a 
parameter tlag, and the number of the compartments in the delay has been set 
equal to 5. You can confirm this by double-clicking on Delay 3, and 
examining the Delay Attributes dialog box. Also the time of the experiment 
has been set to 480 minutes. Thus when you click on Experiment in the 
SAAM II Toolbox, the Experiment Attributes dialog box will not open as is 
normally the case; the Create Experiment dialog box will open. 

 
3. Create the iv experiment. 
 

a. In the SAAM II Toolbox, click Experiment. The Create Experiment dialog 
box will open. 

 
b. Change the name of the experiment from “Exper” to “ivplasma”. The Create 

Experiment dialog box will appear as follows: 
 

 
 
c. Click Create. The model will appear as follows: 
 

 
4. Create the experimental input and sample for the iv experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1 and then the Drawing Canvas. The sample s1 will 

appear associated with Compartment q1. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “ivplasma” in the Associate with Data Name box. 
 

Rev. 11/01/05 IO_US-21 2003 - 2005 University of Washington 



Using SAAM II Multiple I-O Experiments 

e. Edit the sample equation to read “s1=q1/V1”. The Sample Attributes dialog 
box will appear as follows: 

 

 
 
f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q1 and then the Drawing Canvas. The input ex1 will 

appear associated with Compartment q1. 
 
i. Specify the 20 minute infusion. 
 

(1) Double-click ex1 to open the Exogenous Input dialog box. 
 
(2) Select Infusion in the Input Type pane. 
 
(3) Type “12500” in the Constant Rate box. 
 
(4) Type “0” in the Event Start box. 
 
(5) Type “20” in the Event Stop box. 
 
(6) Click Add. The Exogenous Input dialog box should appear as follows: 
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(7) Click Done. The model will appear as follows: 

 

 
 

This is the model to describe the iv plasma data following the 20 minute 
constant infusion of drug. Notice that neither Compartment q4 nor Delay d3 
will play any role whatsoever in describing the iv plasma data. 

 
5. Create the experiment for introducing the drug in suspension. 
 

a. In the SAAM II Toolbox, click Create. The Create Experiment dialog box 
will open. 

 
b. Change the name of the experiment from “Exper” to “suspension”. The 

Create Experiment dialog box will appear as follows: 
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c. Click Create. The model will appear as follows: 
 

 
 
Notice the compartment numbers have changed from, for example, q4 to q4.1. 
The “.1” means this is an experiment separate from the case where these is no 
such label. This is how SAAM II does its book keeping for multiple 
experiments. 

 
6. Create the experimental input and sample for the suspension experiment. 
 

a. In the SAAM II Toolbox, click Sample. 
 
b. Click Compartment q1.1 and then the Drawing Canvas. The sample s2 will 

appear associated with Compartment q1.1. 
 
c. Double-click s2 to open the Sample Attributes dialog box. 
 
d. Type “suspension” in the Associate with Data Name box. 
 
e. Edit the sample equation to read “s2=q1.1/V1. The Sample Attributes dialog 

box will appear as follows 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Input. 
 
h. Click Compartment q4.1 and then the Drawing Canvas. The input ex2 will 

appear associated with Compartment q4.1. 
 
i. Double-click ex2 to open the Exogenous Input dialog box. Be sure “bolus” is 

selected as the Input Type. 
 
j. In the Initial Amount box, type “2.5e+05”. 
 
j. Click Add. 
 
l. Click Done. The model will appear as follows: 
 

 
 

This is the model to describe the suspension data following the bolus 
introduction of the drug as a suspension in the upper GI. Now both 
Compartment q4 and Delay d3 will play any role in describing the suspension 
data. The data can be analyzed together because the “iv” experiment will 
analyze these data while the above will analyze the suspension data. The 
parameters in common are k(2,1), k(1,2), k(0,1) and V1. 

 
7. Enter the parameter values. 
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Besides the system model parameters k(2,1), k(1,2), k(0,1) and V1, there are the 
parameters describing absorption. These are tlag, the time of the delay, and k(3,4) 
and k(0,4). 
 
Compartment 4 is the compartment into which the suspension is introduced, and 
hence is really a part of the delay which is the GT tract. Thus Compartment 4 
should turn over at approximately the same rate as the compartments in the delay. 
These turn over at the rate “tlag/5”, i.e. the delay time divided by the number of 
compartments in the delay. 

 
 However not all of the suspension may be absorbed. Define a new parameter “pa” 

equal to the fraction absorbed. Then you can write: 
 
 k(3,4) = pa*(5/tlag) 
 k(0,4)=(1-pa)*(5/tlag) 
 

This will allow you to estimate the fraction, or percent, of the drug in suspension 
absorbed. 
 
a. Double-click k(3,4) to open the Transfer Attributes dialog box. 
 
b. In the Equation pane, type the equation “k(3,4) = pa*(5/tlag)”. The Transfer 

Attributes dialog box will appear as follows: 
 

 
 
c. Click Done. 
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d. Double-click k(0,4) to open the Loss Attributes dialog box. 
 
e. In the Equation pane, type the equation “k(0,4) = (1-pa)*(5/tlag)”.  
 
f. Click Done. 
 
g. Open the Parameters dialog box. The value for tlag is already in the study 

file. Enter the remaining parameters as shown in the Parameters dialog box 
below: 

 

 
 
h. Click Done. Notice the default Low and High Limits have not been used for 

V1, pa or tlag. The reason for V1 is that it is known with more accuracy than 
the default Low and High Limits would indicate. The reason for pa is that it 
is a fraction, and cannot exceed “1”. The reason for tlag is that the lag time 
cannot be longer than the experiment itself. 

 
8. Solve the model and view the solution. The plot of s1:ivplasma and 

s2:suspension will appear as follows: 
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9. Fit the model to the data. The plot will be updated as follows: 
 

 
 
 The statistics will appear as follows: 
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 Close the Plot and Statistics windows. 

 
Quit the SAAM II Compartmental application. Do not save the changes to io_expt.stu. 
The study file with the parameter values before the fit has been saved as 
io_exp_final.stu. 

 

 Multiple input-output study. In studies such as this one where, on different 
occasions, a drug is administered iv and later orally (or in this case, as a 
suspension), there are two essential assumptions made when analyzing the 
data simultaneously: 

 
 Assumption 1: The subject is in the same “condition” during the two separate 

studies. That is, the determinants of how the drug is metabolized are the same 
on both days of the study. 

 
 Assumption 2: The metabolism of the drug that is absorbed into the systemic 

circulation is identical to that when the drug is introduced directly  by iv. 
 
 For each such study, these assumptions must be considered if the “system 

model” is to be assumed identical for both studies. 
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